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Getting Started
 1

Backup Exec is a powerful backup solution for Windows designed to protect your 
valuable data. This user manual provides detailed information and procedures for 
installing, using, and navigating within Backup Exec. Other valuable information is 
available through Backup Exec's On-line Help.

Where to Look—Getting Started

For information about See

Installing and configuring 
Backup Exec

“Installing Backup Exec” on page 8

Using Automatic Data Protection “Automatic Data Protection” on page 13

Backing up and restoring your files 
quickly

“One-Button Backup” on page 14 and

“One-Button Restore” on page 16

Creating the Disaster Recovery Set “Creating the Disaster Recovery Set” on 
page 58

Using Disaster Recovery “Disaster Recovery” on page 62

Restoring all your files without 
Disaster Recovery diskette(s)

“Restoring All Your Files” on page 67

Using Backup Exec’s Wizards to 
create backup and restore jobs

“Using the Backup Wizard” on page 29 
and “Using the Restore Wizard” on 
page 70

The Backup window and options “Where to Look—Backup” on page 25

The Restore window and options “Where to Look—Restore” on page 57

The Compare window and options “Where to Look—Compare” on page 83

Solving common problems “Troubleshooting Tips” on page 97 
7



Installing Backup Exec
Installing Backup Exec
This section provides system requirements and installation instructions.

System Requirements 

For Windows NT

Make sure your computer meets the following requirements before you begin the 
installation.

◆ IBM or 100% compatible 486 or higher

◆ 16 MB RAM or more

◆ Windows NT Workstation 4.0 

◆ A hard drive with at least 10 MB free

◆ A Microsoft or 100%-compatible mouse is highly recommended

Note This product is not intended for use on an NT server.

For Windows 9x

Make sure your computer meets the following requirements before you begin the 
installation.

◆ IBM or 100% compatible 486/DX or higher

◆ 10 MB RAM or more

◆ Windows 95 or Windows 98

◆ A hard drive with at least 10 MB free

◆ A Microsoft or 100%-compatible mouse is highly recommended

Getting technical assistance “Technical Support” on page 107

For information about See
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Installing Directly from a CD-ROM

▼ To install Backup Exec directly from your CD-ROM:

1. Insert the CD-ROM disc into your CD-ROM drive.

The CD Browser appears.

2. Follow the instructions on your screen to install the program.

Or,

1. If the CD Browser does not appear, select Run from the Start menu.

2. Type (Your CD-ROM drive letter):\SETUP.EXE and press OK. 

The CD Browser appears. 

3. Follow the instructions on your screen to install the program.

Installing from Floppy Diskettes

1. Start Windows.

2. Insert the installation diskette in drive a: (or b:).

3. Choose Run from the Start menu and type a:setup or (b:setup).

4. Select the destination directory for your files.

5. Review the README file.

Reboot your system to complete the installation.

Note If you are upgrading from a previous version of this program, the catalog 
automatically converts to the current Backup Exec format during installation. The 
time required for the conversion may be significant depending on the size of your 
old catalog and the speed of your system.

Configuring Your Backup Device

Most types of backup devices are automatically detected and configured the first time you 
run Backup Exec. Your backup device will be listed in the Where to Back Up box.
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Note For Windows 9x only-- If your backup device is not detected, see “Backup Device 
Configuration” on page 97 for troubleshooting information.
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NetWare Support
NetWare support provided by Backup Exec includes the capability to back up the 
NetWare 3.11-3.12 server bindery, and NetWare file and directory attributes from server 
volumes, including trustee information. Use the Back up Bindery... option to back up your 
Netware bindery files. See “Advanced Tab” on page 50 for more information on this 
option.

All NetWare file attributes and trustee information is backed up, except MAC name space. 
When these files are restored to a NetWare volume, the extended information also 
restores. If the trustee information is not applicable to the restore location, it will not 
restore. An error message is posted to the log file if this occurs.

A network administrator on a NetWare 3.11-3.12 server can back up and restore the server 
bindery. The bindery is automatically selected for backup if any file from the SYS volume 
is selected and the bindery option in the Options dialog is also selected. Restore works 
similarly. If the Restore Bindery option is selected in the Options dialog, and any file on 
the SYS volume is selected for restore, you are prompted to restore the bindery.

Note For trustees, EAs, and bindery backup or restore the user must be logged into the 
server as a network administrator and the Novell 32-bit NetWare client must be 
installed.

Although NetWare Directory Services may appear in the selection panes, please be aware 
that their folder structures cannot be backed up or restored.

Note Backup Exec can not be used to back up Directory Services and file and directory 
attributes from NetWare 4.x-5.x server volumes, including trustee information. 
NetWare 4.x-5.x data files, however, can be backed up and restored.
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Starting Backup Exec
When you install Backup Exec, the program and its folder are added to the Windows Start 
menu. If you chose to have the Backup Exec icon added to your desktop during 
installation, you may double-click this icon to open the program.

▼ To start your backup software:

1. Click the Start button on the Windows taskbar.

2. Select Programs, Backup Exec and point to the Backup Exec folder.

3. Click Backup Exec.

4. Backup Exec opens and also appears on the taskbar. 

5. The Backup Exec Startup window displays.
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Quick Start
This section shows how to back up and restore your files easily and quickly using 
Automatic Data Protection, One-Button Backup, and One-Button Restore. Before you 
start, be sure your backup devices have been detected and configured by Windows. See 
“Configuring Your Backup Device” on page 9.

Automatic Data Protection

Automatic Data Protection ensures your data is backed up on a regular basis. When you 
first start the application, you are prompted with the option of initiating Automatic Data 
Protection. Any job created with Automatic Data Protection can later be edited with 
Backup Exec. 

Power Management Properties--If you set your Advanced Power Management settings to 
turn off the hard disks after a set period of time, Backup Exec will not be able to re-start 
your computer in order to run a scheduled backup job. 

Note If Microsoft System Agent or Internet Explorer (4.x or higher) Task Scheduler is 
installed on your machine, you may use either of these to schedule a job created 
with Automatic Data Protection (See “Scheduling a Backup Job” on page 51).

▼ To use Automatic Data Protection:

1. Select a day of the week for the backup job to run, or select Day or Weekday. 

If you choose a day of the week, the New and changed files option is displayed. If you 
choose Day or Weekday, the New and changed files option is not displayed and All 
Selected Files backups are automatically performed.

2. Click OK.
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One-Button Backup 
One-Button Backup launches a backup of all local hard disks, including the Windows 
Registry.

▼ To use One-Button Backup:

1. Double-click the One-Button Backup icon on the Desktop. Or, click the Start menu, 
select Programs, Backup Exec, and then click One-Button Backup. 

The One-Button Backup dialog appears.

2. Select a device or File in the drop-down list box. If you select File, a text box and 
browse button appear. The file option enables you to back up your data to a custom 
location, such as a hard disk, a network drive, a floppy diskette, or removable media. 
See “Where to Back Up” on page 35 for more information.

3. Click Start. 

Note If your backup job exceeds the space available on a single piece of media, 
Backup Exec will prompt you to insert another blank media when the current one 
has been filled.

The backup will run as either a full or differential backup (with default settings) 
depending on the following criteria.

An All Selected Files backup is performed if:

◆ Ten differential backups have been performed since the last All Selected Files backup, 
regardless of dates.

◆ More than seven days have passed since the last backup.

A differential backup is performed if:

◆ No more than seven days have passed since the last All Selected Files backup.
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Note For more information on full and differential backup types, see “Backup types” on 
page 47.

Default Backup Job Settings

Your backup job will run with the following default settings:

◆ What to back up—All Selected Files. See “What to Back Up” on page 34.

◆ Where to back up—Backup device. See “Where to Back Up” on page 35.

◆ How to back up—

Full Backup—Verify, Compress, Overwrite. 

Differential Backup—Verify, Compress, Append. 

See “How to Back Up” on page 36.
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One-Button Restore
One-Button Restore launches a series of dialogs which help you perform a restore in just a 
few steps.

▼ To run One-Button Restore:

1. Click the Start menu, select Programs, Backup Exec, and then click One-Button 
Restore. 

The One-Button Restore dialog box appears.

2. Select a device or File in the drop-down list box. 

3. Click Next to continue.

4. Check the drives, folders, and files you want to restore.

5. Click Start to begin restoring your files.
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Note If your backup job exceeds the space available on a single piece of media, 
Backup Exec will prompt you to insert another blank media when the current one 
has been filled.

Restore Default Settings

Your restore will run with the following default settings:

◆ What to Restore—Folder view. See “What to Restore” on page 75.

◆ Where to restore—Original Location. See “Where to Restore” on page 76.

◆ How to restore—Always replace. See “How to Restore” on page 77.
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Using Backup Exec
This section provides an overview of the various tools and features that Backup Exec 
offers.

Menus

The title bar contains five menu items: Job, Edit, View, Tools, and Help. You can access these 
menus and the submenu items at any time.

The Backup, Restore, and Compare tabs appear at the top of the main application window. 
Click these tabs to move between program functions. 

Toolbar

Use Backup Exec’s toolbar to select program features with a single mouse click. Hold the 
cursor over a button for a short description of its function.

Toolbar buttons (listed from left to right) perform the following functions:

Click: To do this:

Create a new untitled backup job.

Open a saved backup job.

Save the current backup job for future use.

Select one or more highlighted drives, folders, or files, and place 
check marks next to them.

Deselect one or more highlighted drives, folders, or files, and 
remove the check marks next to them.
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Selection Panes

Drives and files are selected the same way in Backup Exec as they are in Windows 
Explorer. Selection panes are used to select and deselect drives, folders, and files for 
backup and restore.

The two sections of the selection panes are:

◆ All Folders Pane—On the left. Displays a list of your computer’s drives and folders. 

Open the Restore File Version dialog box to choose the specific 
version of a file you want restored.

Open the File Find dialog box to find a file for restore. You can 
search by name, location, or date modified..

Open the Backup Wizard, which leads you step-by-step through 
the selection of files, settings, and options for your backup.

Open the Restore Wizard, which leads you step-by-step through 
the selection of files, settings, and options for your restore.

Open the Job Options dialog box, where you can select options 
for the current backup job.

Display your files as small icons in vertical rows (List View).

Display your files in a vertical list with file size, type, and 
modified date (Detail View).

Display a short description of menu items, windows, buttons, 
and boxes when the item is clicked.

Click: To do this:
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◆ Contents Pane—On the right. When a folder is highlighted in the All Folders Pane, 
the files and folders in that folder appear in the Contents Pane. 

Click the Expand/Collapse button to expand or collapse a folder.

◆ A plus sign (+) means the listing can be expanded to display additional folders.

◆ A minus sign (–) means the listing can be collapsed so that folders beneath it are not 
displayed.

◆ Folders without buttons indicate there are no subfolders.

Click a selection check box to select or deselect files and folders. 

◆ An empty check box means the drive, folder, or file has not been selected for backup 
or restore.

◆ A blue checkmark means one or more items in a folder have been selected for backup 
or restore.
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◆ A gray checkmark means that some, but not all, of a drive or folder has been selected.

◆ A red X means that the file’s type has been excluded. See “Exclude Tab” on page 47 for 
more information.

Help

The Backup Exec on-line help system provides in-depth information about the program 
and its functions.

Context-Sensitive Help

Context-sensitive help provides you with information about the current window, dialog 
box, or program message. To get context-sensitive help on the current operation, press 
Shift+F1 on your keyboard.

Help Menu

The Help menu provides help for each program function and assistance with backup and 
restore concepts and skills. There are three items in the Help menu: Help Topics, Using Help, 
and About Backup Exec.

Help Topics

Help Topics opens the Help window, which contains three tabs.
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◆ The Contents tab displays a list of topics in the help system arranged by category.

◆ The Index tab lists keywords alphabetically. Type the first few letters of a keyword 
and the first matching item is highlighted.

A book represents a help category containing subtopics. 
Double-click the book to open it.

An open book displays a list of topics and books.

A page represents a help topic. Double-click it to open the help 
window for that topic.
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◆ The Find tab provides a full-text search utility for any word or phrase in help. You 
must set up the search file the first time you use the Find tab. Then type a word or 
phrase and select a topic from the list. 

Using Help

The Using Help menu item provides help for the help system. It explains how to use Help 
effectively and how to customize your Help system.

About Backup Exec

About Backup Exec displays your software’s version number and licensing information.

Exiting Backup Exec

◆ On the Job menu, click Exit.

Or,

◆ Click the Close button.

You are asked if you want to save any changes to your current backup job. Click Yes to 
save your backup job or click No to discard the changes. The application closes.
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Using Backup
 2

This chapter explains how to use the Backup window to copy files from your computer to 
a backup location. It begins by describing the steps needed to perform a backup using 
Backup Exec. 

Your first backup should be of your entire computer. After you have backed up your 
computer, you can create backup jobs to save your options and file selections. By creating 
several jobs, you can customize your backups and protect your data quickly and, if you 
wish, automatically. 

You can use the Backup Wizard or the Backup window to create a backup job. Selections 
and options are described in later sections of this chapter.

Where to Look—Backup

▼ For more help on backup topics, see: 

◆ “One-Button Backup” on page 26

◆ “Backup Jobs” on page 28

◆ “Using the Backup Wizard” on page 29

◆ “The Backup Window” on page 34

◆ “Backing Up Files with the Backup Window” on page 37

◆ “Using Backup Jobs” on page 39

◆ “The Backup Set” on page 42

◆ “Backup Options” on page 43

◆ “Scheduling a Backup Job” on page 51
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One-Button Backup
One-Button Backup launches a backup of all local hard disks, including the Windows 
Registry.

▼ To use One-Button Backup:

1. Double-click the One-Button Backup icon on the Desktop. Or, click the Start menu, 
select Programs, Backup Exec, and then click One-Button Backup. 

The One-Button Backup dialog appears.

2. Select a device or File in the drop-down list box. If you select File, a text box and 
browse button appear. The file option enables you to back up your data to a custom 
location, such as a hard disk, a network drive, a floppy diskette, or removable media. 
See “Where to Back Up” on page 35 for more information.

3. Click Start.

Note If your backup job exceeds the space available on a single piece of media, 
Backup Exec will prompt you to insert another blank media when the current one 
has been filled.

The backup will run as either a full or differential backup (with default settings) 
depending on the following criteria.

An All Selected Files backup is performed if:

◆ Ten differential backups have been performed since the last All Selected Files backup, 
regardless of dates.

◆ More than seven days have passed since the last backup.

A differential backup is performed if:

◆ No more than seven days have passed since the last All Selected Files backup.
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Note For more information on full and differential backup types, see “Backup types” on 
page 47.

Default Backup Job Settings

Your backup job will run with the following default settings:

◆ What to back up—

Full Backup—All Selected Files. 

Differential Backup—New and changed files

See “What to Back Up” on page 34.

◆ Where to back up—Backup Device. See “Where to Back Up” on page 35.

◆ How to back up—

Full Backup—Verify, Compress, Overwrite. 

Differential Backup—Verify, Compress, Append. 

See “How to Back Up” on page 36.
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Backup Jobs
Backup Exec uses backup jobs to save and reuse file and option selections. You create a 
backup job by selecting drives and files for backup, choosing program settings and 
options, and saving your selections with a new job name.

A backup job includes all selections made at the time it is saved:

◆ Drives, folders, and files to back up

◆ Backup type

◆ Backup device

◆ Options selected or default selections

Backup jobs can be opened, saved, and deleted using the Job menu. In the Backup 
window, you can open a backup job with the Backup Job list.

To change a backup job, simply make new file or option selections. When you run a 
backup, your changes are automatically saved. To save your changes under a different 
name, choose Save As from the Job menu and enter a new name, or type the new name in 
the Job Name field. If you attempt to save a new job using an existing name, the program 
asks you whether or not to overwrite the existing job. If you choose overwrite, the new job 
replaces the existing job. 

You can use the Backup Wizard (“Using the Backup Wizard” on page 29) or the Backup 
window (see “The Backup Window” on page 34) to create new backup jobs or you can 
modify and rename existing job files.

By saving your backup jobs, you can run them again without making your selections 
again. 

The Backup Job box lists your saved backup jobs. Type a new name in the box to save the 
job under a different name.

Note You must make file selections before saving your backup job.
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Using the Backup Wizard
The Backup Wizard is a series of dialog boxes that guides you through the steps required 
to create a new backup job. 

The Backup Wizard is used to create new backup jobs. It cannot be used to modify an 
existing job.

Using the Wizard is easy. All you need to do is make selections by clicking the appropriate 
options. After you’ve made your selections, click the Next button and the Wizard displays 
the next step. 

▼ To create a job using the Backup Wizard:

1. Click Backup Wizard in the Startup window, then click OK. 

Or,

Click the Backup Wizard icon on the toolbar.

The What to Back Up window of the Backup Wizard is displayed.

2. Select the drives and files you want to back up.

To back up all files, folders, and drives on your computer, click Back up My Computer. 
Click Next to continue. The Backup Type Wizard window appears.

Or,

To back up only some of the files, folders, or drives on your computer, click Back up 
selected files, folders and drives. 
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The Backup Wizard Selection Panes appear.

Select the specific drives, folders, and files you want to back up. For more information 
on selecting files, see “Selection Panes” on page 19. 

3. Click Next to continue.

4. Select a backup type.

Click All Selected Files to back up all selected files, then click Next. 

Or,

Click New and Changed Files Only to back up only files that are new or have changed 
since the last All Selected Files backup and click Next.

Note New and Changed Files Only will use a differential backup type. For more 
information on backup types, see “Backup types” on page 47. 
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5. Select a destination for the backup from the Where to back up list. See “Where to Back 
Up” on page 35.

6. Click Next to continue.

The How to Back Up Wizard window appears. 

7. Select your backup options for this screen. 

8. Click Next to continue.
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The When to Back Up Wizard appears.

9. Click Now to begin this backup immediately, or click Later to schedule this backup for 
a later time.

Note If you select Later, Microsoft System Agent, Task Scheduler or Backup Exec 
Scheduler must be running.

To back up later, specify the frequency, then set the time, date, and/or days of the 
week to run this backup job. For more information on scheduling your backup job, see 
“Scheduling a Backup Job” on page 51. 

10. Click Next to continue.

The Name the Backup Job window appears.

11. Type a name for this backup job.

12. Review the backup job’s summary. To change an option, use the Back and Next 
buttons. 
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13. Click Start to begin this backup job. The Backup Progress window appears “Backup 
Progress Window” on page 41

Or, Click OK to run your job as scheduled.

Note If your backup job exceeds the space available on a single piece of media, 
Backup Exec will prompt you to insert another blank media when the current one 
has been filled.
Chapter 2, Using Backup 33



The Backup Window
The Backup Window
This section first describes the Backup window. For step-by-step instructions on creating 
backup jobs, see “Backing Up Files with the Backup Window” on page 37.

The Backup window gives you quick access to all the backup job options, and includes 
four main sections.

◆ Backup Job—Select your Backup Job from the drop-down list.

◆ What to Back Up—Select your drives and files to back up from the selection pane. 
Choose the backup type.

◆ Where to Back Up —Select a device to back up to, or select File to back up your files to 
your hard drive, a network drive, a floppy diskette, or removable media.

◆ How to Back Up—Lists your option settings, and displays the Options button.

Backup Jobs List

The Backup Job list box contains all available backup jobs. If you are creating a new 
backup job, Untitled appears as the default name. To save a new backup job, click Save 
from the Job menu.

What to Back Up 

Select your backup type and files in the What to back up section.

Two backup types are displayed in the Backup window under What to back up: All Selected 
Files, and New and Changed Files. 

◆ All Selected Files—Backs up all selected files.
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◆ New and Changed Files—Backs up all the selected files that have changed since the 
last All Selected Files backup.

If you choose New and Changed Files, the default setting is differential backup. Use the 
Options button to change your backup type. See “Type Tab” on page 46 for more 
information and a complete description of each type.

Backup Selection Panes

Backup Exec uses the same drive and file selection methods as Windows. Drives and 
folders are selected in the All Folders Pane and individual files and folders are selected in 
the Contents Pane. Select drives and files to back up by clicking the check box next to the 
item. For more information, see “Selection Panes” on page 19.

Where to Back Up

The drop-down list box in the Where to back up section contains the names of all your 
backup devices. Your backup device is automatically selected as your backup location. To 
change your backup location, select another device in the drop-down list box, or select 
File to back up your files to your hard drive, a network drive, a floppy diskette, or 
removable media.

Backing up to File

The File option enables you to back up your data to a file in some custom location, such as 
a hard disk, a network drive, floppy diskette, or removable media.

The File option does not require that your files are written to media formatted for backup 
use only. You may want to use the File option if you plan on using backup media for other 
purposes as well. However, if you use media formatted for backup use only, you can only 
write backup files to that device.

▼ To back up to a file:

1. Select File in the drop-down list box in the Backup window.

A text box and browse button appear below the drop-down list box. 

Note The Always Append option is not available in file backups.
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2. Type a folder and filename in the text box. If you type a filename without an 
extension, Backup Exec adds a .QIC extension to your file.

Or,

Click Browse, select a folder and a file within that folder, then click OK. The path 
appears in the text box.

Note We recommend entering a filename for your File Backup. However, if you do not 
enter a filename, Backup Exec provides a name for you. For example, if you enter 
C:\SAVE in the text box, Backup Exec will create a backup file called SAVE.QIC on 
your local drive. The path for your backup file would be C:\SAVE.QIC. 

How to Back Up

The Backup Job Options dialog box lets you set your backup options, password protect 
your backup set, and change your backup type. Current option settings are listed above 
the Options button. For information about backup options, see “Backup Options” on 
page 43.
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Backing Up Files with the Backup Window

▼ To back up your files using the Backup window:

1. Select New from the Job menu. 

The Backup window appears.

2. Select What to back up. All selected files is the default setting. To change your backup 
type, click New and changed files.

See “Type Tab” on page 46 for more information.

3. Select the files to back up. Click the check boxes next to the drives and files you want 
to back up.

A checkmark indicates the drive, file, or folder is selected for backup. A red X 
indicates that the file’s type is excluded.

See “Selection Panes” on page 19 for more information.

4. Select Where to back up. To change your backup destination, make your selection in 
the drop-down list. See “Where to Back Up” on page 35.

5. Select How to back up. The default settings are Full Compression and Prompt. To change 
your backup options, click Options. The Backup Options dialog box lets you set each of 
your options. See “Backup Options” on page 43.
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6. Click Schedule to run your job at a later time. See “Scheduling a Backup Job” on 
page 51.

Or,

Click Start to run your backup job now. Your backup job is saved. See “Backup 
Progress Window” on page 41.

Or,

Select Save from the Job menu to save your job for future use. The name you give it 
will appear in the Backup Job list.
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Using Backup Jobs

▼ To open a backup job:

1. Click the Backup tab in the main application window.

2. Highlight a job name in the Backup Job combo box.

The backup job settings appear.

Or,

Choose Open from the Job menu. 

The Open Backup Job dialog box appears.

3. Select a Backup Job from the list. 

Or, 

Type a job name (description) in the Job to open text box.

4. Click Open.

▼ To change settings in an existing backup job:

1. Open the backup job you want to modify and make your changes.

2. Choose Save As from the Job menu.
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The Save Backup Job As dialog box appears. It is identical to the Open Job dialog box.

3. Type a name into the Job Name text box. You may type a name of up to 130 characters 
(including spaces).

4. Click Save.

▼ To delete a backup job:

1. Choose Delete... from the Job menu.

The Delete Backup Job dialog box appears. It is identical to the Open Job dialog box.

2. Select a Backup Job, or type a job name (description) in the Job Name text box.

3. Click Delete. You are asked to confirm your action. Click Yes to continue.

▼ To run your backup job:

❖ Click Start. 

If your backup job is new or modified, the program prompts you to save the backup. 
The new job overwrites an older backup job, if one exists.

Note If your backup job exceeds the space available on a single piece of media, 
Backup Exec will prompt you to insert another blank media when the current one 
has been filled.
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Backup Progress Window

The Backup Progress window appears when you start your backup. It continually 
updates information about your backup job. 

The name of the backup job in progress is displayed in the window title bar.

The top section displays the backup device, media name, and the current status of the 
backup job. 

The center section displays a progress bar showing the percentage of the backup job 
completed and the estimated time remaining, along with time elapsed since job start.

The bottom section displays the name of the file currently being processed, the estimated 
number and size of files to be backed up and already processed, and the compression 
ratio. 

When the backup is complete, the OK and Report button replace the Cancel button. Click 
Report for a summary of your backup or click OK to continue.

Canceling Your Backup

You can cancel the backup at any time by clicking Cancel or pressing Esc.

Canceling your backup may take several minutes, depending on the size of the backup 
set.

Caution If you cancel a backup, some backup devices will not be able to recover the 
space already used by the backup on the media. To use this space, you will have 
to erase or overwrite the entire media.
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Viewing Your Backup Report

When the backup completes, the Cancel button changes to OK, and a Report button is 
displayed below it. Click Report to view a summary of your backup or click OK to 
continue. You can also use the Report option in the Tools menu to view your backup 
report at a later time.

The Backup Set

After you perform a backup job, your files are stored on the media in a special format 
called a backup set. If your backup uses two or more media, one backup set is stored on 
each piece of media. Information about each backup set is stored in the catalog. For 
information about catalogs, see “Import Catalog” on page 93.
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Backup Options

▼ To open the Backup Job Options dialog box:

❖ Click Options in the How to backup section.

The Backup Job Options dialog box appears.

Backup Job Options Dialog Box

The Backup Job Options dialog box contains the following tabs:

◆ “General Tab” on page 44

◆ “Password Tab” on page 45

◆ “Type Tab” on page 46

◆ “Exclude Tab” on page 47

◆ “Report Tab” on page 49

◆ “Advanced Tab” on page 50

▼ To display an option group:

❖ Click on a tab.

The option group appears.

▼ To select an option or change an option setting:

❖ Click on the check box or button next to the option.

▼ To save your current settings and change option groups:

1. Click Apply.

2. Click the next option group’s tab. 

▼ To save your option settings and return to the Backup window:

❖ Click OK.

Your backup options are saved and you return to the Backup window.
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General Tab

Use the General tab to set the Verify data and Compression options and tell Backup Exec 
how to handle media that already contain backups.

◆ Verify Data by performing a file-by-file compare after the backup has been 
completed.

If you back up with the Verify Data option on, Backup Exec will verify the data by 
reading it back from the backup media after writing it and comparing it to data on the 
disk. Because Verify Data takes twice as long, you may choose to turn this option off. 
However, it is strongly recommended that you use Verify Data to help ensure the 
reliability of your backups.

◆ When backing up to media

Never compress the data—Turns data compression off (does not control hardware 
compression).

Compress data to save time during backup—Compresses your data as much as 
possible with a minimum reduction in speed.

Maximize compression to save space on media—Compresses your data as much as 
possible without regard to speed. This may cause your backup to take longer, 
however the resulting backup set will use less space.

Compression uses a “shorthand” to reduce file sizes, so that data can be written in less 
space.

Note If your data has already been compressed, select Never compress the data. 
Compressing data that has already been compressed causes the data to occupy 
more media space.

◆ If the media already contains backups
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Append this backup to my media—Your data is placed after the last backup set on the 
media.

Overwrite the media with this backup—Overwrite works differently depending on 
your backup location. If you are using a backup device, Overwrite replaces all files on 
the media with the files selected for backup. To avoid overwriting all files on the 
media, choose Append. 

Caution All files on the media are erased before the new backup set(s) are written.

If you are using the "File Option" for your backup, Overwrite does not erase all files 
on your hard drive, network drive, floppy diskette, or removable media. Overwrite 
only replaces a file with the same name as a file selected for backup. For example, if 
the name of your backup file is save.QIC and there is a file on your floppy diskette 
that is also named save.QIC, only that file will be overwritten. Any other files on the 
floppy are not overwritten.

Let me choose this option during the backup—The name of the media in the drive is 
displayed when the backup job begins, and you are prompted to choose Overwrite or 
Append.

◆ If the media is blank

Use this media name—You can name the media if it is blank by typing a name in the 
text box.

Click Apply, then click OK or another options tab.

Password Tab

Use the Password tab to provide data security by password-protecting your backup. Your 
password is required to compare or restore files in the backup set.

Your password may consist of up to 8 characters. Passwords are case-sensitive. For 
example, “my pass” is not the same as “My Pass”.

Caution Make careful note of your password. Without it, you will not be able to access or 
recover data in your password-protected backup set. 
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▼ To create a password:

1. Click Protect this backup with a Password. 

2. Type your password in the Password text box.

3. Retype your password in the Confirm password text box.

4. Click Apply.

5. Click OK or select another options tab.

Type Tab

Use the Type tab to choose a backup type.
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Backup types

◆ All selected files—Backs up all the files you have selected.

◆ New and changed files only—If you choose New and changed files, two additional 
backup types are displayed. 

Differential backup type—Backs up all the selected files that have changed since the 
most recent All Selected Files backup. Recommended if you frequently restore files to 
your system.

Incremental backup type—Backs up all selected files that have changed since the most 
recent All Selected Files or Incremental backup. Recommended if you do not 
frequently restore files to your system.

For a comparison between the two backup types, see the table below:

Exclude Tab

Use the Exclude tab to exclude certain file types from your Backup Job. File exclusions are 
made based on registered types or custom types. 

Note Excluded file types are marked in the selection panes with a red X.

Table 1. Differential vs. Incremental backups

Differential backups Incremental backups

Faster restores—You only need to 
restore the most recent Full Backup 
and Differential backup(s).

Slower restores—You must restore 
the Full Backup media set, plus each 
Incremental backup media.

Slower backups—A comparison 
of all the files on your system must 
be run to determine which files 
have changed, or have been added 
since the last Full backup.

Faster backups—You only need to 
back up those files that have 
changed, or have been added since 
the last Incremental backup.

Uses less media—One backup set 
for the Full backup and one set for 
the Differential backup.

Uses more media—One backup set 
for the Full backup and one set for 
each of the Incremental backups.
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▼ To exclude files by registered type:

1. Click the Exclude tab in the Backup Job Options dialog box.

The Exclude tab appears.

2. Click Add. 

The Exclude files from backup dialog box appears. 

3. Click Registered type.

4. Select the file type you want to exclude in the Registered types list. 

5. Click OK. 

Your exclusion appears in the Do not back up these file types list box. To exclude 
additional registered file types, repeat steps 2 through 5.

▼ To exclude files by custom type:

1. Click the Exclude tab in the Backup Job Options dialog box.

The Exclude tab appears.

2. Click Add. 

The Add Exclude dialog box appears. 

3. Click Custom type.

4. Type a three letter file extension in the Custom type text box. 

For example, type bat to exclude all your batch files.
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5. Click OK.

Your exclusion appears in the Do not back up these file types list box.

To exclude additional file types, repeat steps 2 through 5. 

▼ To remove a file type from the Do not back up these file types list:

1. Select the file type you want to remove from the list. 

2. Click Remove.

Tip For a current list of files automatically excluded from backups, visit our support site 
knowledge base at the <a href="http://www.support.veritas.com">VERITAS Support 
Web site</a>: http://www.support.veritas.com

Report Tab

Use the Report tab to specify the items you want to include in your backup report and to 
set your unattended backup option. 

◆ List all files that were backed up—Includes a list of the files that were selected and 
successfully backed up.

◆ List files that were not backed up—Includes a list of the files that were selected, but 
not successfully backed up.

◆ List errors reported while backing up files—Includes a list of any errors encountered 
while performing a backup of files.

◆ List warnings reported while backing up files—Includes a list of any warnings 
encountered while performing a backup of files.
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◆ List unattended messages and prompts—Includes a list of any messages and prompts 
encountered while performing an unattended backup.

◆ Show report summary—Includes a report summary of the results of the backup job.

Unattended backup

Check Unattended backup to run unattended backup jobs. This option enables the 
program to bypass most prompts during a backup operation. Unattended backup is the 
default setting.

Advanced Tab

Use the Advanced tab to specify the following options:

◆ Back up Windows Registry—Backs up the Windows Registry. The Registry is 
automatically selected for backup when your local drive is selected. 

▼ To set the Advanced Options:

1. Click the Advanced tab in the Backup Job Options dialog box.

The Advanced tab appears.

2. Check the options you want.

3. Click OK.
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Scheduling a Backup Job
Backup Exec provides a simple, yet flexible way to schedule your backup jobs. The 
scheduling process is simplified by a series of dialog boxes that guide you through the 
process of scheduling your backup job.

If you are running Microsoft System Agent or Internet Explorer (4.x or higher) Task 
Scheduler on your machine, these schedulers will automatically be used to run your 
scheduled backup jobs. 

If neither System Agent nor Task Scheduler is installed on your machine, Backup Exec 
provides a scheduler for you. 

Note The Backup Exec Scheduler will not run if you have the Microsoft System Agent or 
Task Scheduler installed.

When running Backup Exec after initial installation, a prompt appears asking if you 
would like to start the Backup Exec Scheduler. Click Yes to start the scheduler. If No is 
selected at this time, the prompt will re-appear when you attempt to schedule a backup 
job.

▼ To Schedule a backup job:

1. Click Schedule on the Backup window.

The Schedule Job dialog box appears. 

2. Select Once, Daily, Weekly, or Monthly.

The program displays option settings that correspond to your selection. For example, 
if you select Weekly, the program prompts you to choose a time and the day of the 
week for your backup job. See “Setting Frequencies for the Scheduled Job” on page 52 
for additional information.

3. Choose your settings.

4. Click OK, then click Yes to confirm the operation or No to cancel.
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Note Backup Exec will not be able to run a scheduled backup job if Backup Exec is 
running at the time your job is scheduled to run, if Windows is not running at the 
time your backup job is scheduled to run, or if your Advanced Power Management 
settings have turned off the hard disks after a set period of time.

Setting Frequencies for the Scheduled Job

When you schedule a backup job, the settings that appear depend on the frequency you 
choose:

◆ Once— Set the time and the date.

◆ Daily—Set the time. 

◆ Weekly—Set the time and the day of the week. 

◆ Monthly—Set the time and the day of the month.

Note If Task Scheduler is installed on your machine, the Which Days button will be 
available when the Weekly setting is selected.
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Changing When a Scheduled Backup Job Runs

Backup Exec allows you to modify a scheduled backup job by changing the settings in the 
Backup window, or Schedule button. When you are done modifying a particular backup 
job, click Save from the Job menu, and the modified backup job will run at the next 
scheduled time. 

▼ To change your backup job schedule from Backup Exec:

1. From the Backup window, select the job you wish to change in the Backup Job 
drop-down list box. 

2. Click the Schedule button and select the new settings for your scheduled backup job.

3. Click OK. 

These changes will be updated in the Microsoft System Agent, Microsoft Internet Explorer 
4.x Task Scheduler, or the Backup Exec Scheduler, depending on which is installed.

Note The Backup Exec Scheduler will not run if the Microsoft System Agent or Internet 
Explorer 4.x Task Scheduler is installed on your system.

▼ To change a scheduled backup job with the Microsoft System Agent:

1. Double-click the calendar icon on the taskbar to open the Microsoft System Agent.

The Microsoft System Agent appears.

2. Highlight the scheduled backup job you want to change, then select Change 
Schedule... from the Program menu.

3. Make your changes, then click OK.

Refer to your Windows documentation for instructions on using the Microsoft System 
Agent.

▼ To change a scheduled backup job with Task Scheduler:

1. Double-click the calendar icon on the taskbar to open Task Scheduler.

Note If you are running Windows NT, open the Task Scheduler from the Start menu, 
Programs, Administrative Tools, then click Scheduled Tasks.

Task Scheduler appears.
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2. Highlight the scheduled backup job you want to change, then select Properties from 
the File menu.

3. Make your changes, click Apply, then click OK.

Refer to your Windows documentation for instructions on using Task Scheduler.

Note If you modify Advanced settings in Task Scheduler or System Agent, you will not 
be able to edit the job from Backup Exec.

Editing a Scheduled Backup Job

▼ To edit a scheduled backup job:

1. From the Backup window, select the job you wish to edit in the Backup Job drop-down 
list box.

2. Click the Options button and select the new settings for your backup job from the 
Options tabs.

3. Click Apply, then click OK or select another Options tab.

4. From the Job menu, click Save.

These changes will be updated in the Microsoft System Agent, Microsoft Internet Explorer 
4.x Task Scheduler, or the Backup Exec Scheduler, depending on which is installed.

Removing a Scheduled Backup Job

You can use the Backup Exec Scheduler or your installed scheduler to remove a scheduled 
backup job. For more information on the Backup Exec Scheduler, refer to the Backup Exec 
Scheduler Help by running the Backup Exec Scheduler and choosing from the Help menu.

▼ To remove a scheduled backup job from Backup Exec:

1. Select Delete... from the Job menu.

2. Highlight the item you wish to remove, or type the job name in the text box, then click 
Delete.

3. Click Yes to confirm the operation or No to cancel.
54 Using Backup Exec



Scheduling a Backup Job
▼ To remove a scheduled backup job from the Microsoft System Agent:

1. Double-click the calendar icon on the taskbar to open the Microsoft System Agent.

The Microsoft System Agent appears.

2. Highlight the scheduled backup job you wish to remove, then select Remove from the 
Program menu.

3. Click Yes to confirm the operation, or No to cancel.

▼ To remove a scheduled backup job from Task Scheduler:

1. Double-click the calendar icon on the taskbar to open the Task Scheduler.

Note If you are running Windows NT, open the Task Scheduler from the Start menu, 
Programs, Administrative Tools, then click Scheduled Tasks.

Task Scheduler appears.

2. Highlight the scheduled backup job you wish to remove, then select Delete from the 
File menu.

3. Click Yes to confirm the operation or No to cancel.

Note Removing a scheduled backup job using the Microsoft Internet Explorer 4.x Task 
Scheduler or Microsoft System Agent will prevent the scheduled backup from 
running, but will not delete the backup job in Backup Exec.
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Using Restore
 3

This chapter explains how to use Disaster Recovery, the Restore Wizard and the Restore 
window to restore files to your hard disk. Restore reads the selected backup sets and 
restores your files to a specified location (usually their original location). You can restore 
one file, several selected files, or all files from a backup set. You can also select individual 
versions of a file, specify the destination for the restored files, and set options.

Whether you are restoring your entire system, a single file, or a particular version of a file, 
Backup Exec makes it simple to set up the restore process. You can use either the Restore 
Wizard or the Restore window to specify your restore.

Where to Look—Restore

▼ For more help on restore topics, see:

◆ “Disaster Recovery” on page 62

◆ “One-Button Restore” on page 65

◆ “Restoring All Your Files” on page 67

◆ “Using the Restore Wizard” on page 70

◆ “The Restore Window” on page 73

◆ “Restoring Files with the Restore Window” on page 81

◆ “Restore Progress Window” on page 82

◆ “Advanced Tab” on page 79
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Creating the Disaster Recovery Set
The first step in securing the data on your system is creating the Disaster Recovery (DR) 
Set. The DR Set will contain the information necessary to recover your system. 

The Recovery Wizard will guide you through the steps required to create the DR Set with 
easy-to-follow instructions for protecting your valuable data. Once the DR Set has been 
created, it will allow you to recover your system should your hard drive fail, even if your 
Windows operating system will not start.

The first time Backup Exec launches, you are prompted to create Disaster Recovery 
Diskettes. If you do not create Disaster Recovery Diskettes at that time, you may do so 
later by choosing Recovery Wizard from the Tools menu. 

If you installed a new backup device since you created your DR Set, you must create a 
new DR Set to accompany your new backup device. If the backup device listed is not 
found, Disaster Recovery cannot complete.

To create the Disaster Recovery Set, you will need the following items:

For Windows 9x

◆ One or more blank, formatted 1.44MB diskettes

◆ Windows 9x installation CD

◆ Media for your backup device

For Windows NT

◆ Five (5) blank, formatted 1.44MB diskettes

◆ Windows NT installation CD

◆ Media for your backup device

Note The amount of media required for the DR Set will depend on the amount of data on 
your system. 

Windows 9x Disaster Recovery Set

It is recommended that you label your media when prompted in the Wizards, and 
store your DR Set in a safe place. A new Disaster Recovery Set should be created when 
new hardware or software has been added to your system, or if many changes have 
been made to your files since the last DR Set was created.
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▼ To create your Windows 9x Disaster Recovery Set:

1. Select Recovery Wizard from the Tools menu.

The Recovery Wizard appears. 

2. Follow the instructions on the Wizard screens to create your Disaster Recovery Set.

Note For Windows 9x only — If you are using a SCSI device for Disaster Recovery, you 
may be prompted for a DOS ASPI driver. Please refer to the README.TXT for 
instructions on entering the correct drivers when creating the DR Set.

Windows NT Disaster Recovery Set

It is recommended that you label your media when prompted in the Wizards, and 
store your DR Set in a safe place. A new Disaster Recovery Set should be created when 
new hardware or software has been added to your system, or if many changes have 
been made to your files since the last DR Set was created.

▼ To create your Windows NT Disaster Recovery Set:

1. Select Recovery Wizard from the Tools menu.

The Recovery Wizard appears. 

2. Follow the instructions on the Wizard screens to create your Disaster Recovery Set.
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Testing your Disaster Recovery Set
After you have created the Disaster Recovery Set, you will be asked if you would like to 
test the DR Set. Testing the DR Set is very similar to performing an actual recovery; 
however, be sure to stop before recovering your data. This test is to verify that your drive 
is responding properly.  

▼ To test your Windows 9x Disaster Recovery Set:

1. Insert the Windows Startup Disk (diskette #1 of the DR Set) into your machine’s 3.5” 
boot floppy drive and restart your computer. 

A DOS screen appears.

2. If a Windows Startup Diskette #2 was created (not all systems require the creation of a 
second diskette), insert that diskette into your machine’s 3.5” boot floppy drive, then 
press any key.

The Disaster Recovery screen appears.

3. Press F5.

Your system files will be copied from the diskette to your hard drive.

The following prompt should appear:

Please insert Disaster Recovery Media #1 into your (device name).

4. If it’s not already in your drive, insert Disaster Recovery Media #1 of your DR Set into 
your device when prompted, then press Enter.

Disaster Recovery scans the media to verify that the drive and the DR Set are 
responding properly. When Disaster Recovery is done scanning the media, you 
should receive a message indicating that the test was successful.

5. Press F10 to exit. 

Caution Do not continue past this step. The test is complete. Please remove any media 
from your drives and restart your computer. 

If you see any error messages during this process, then there is a problem 
communicating with the backup device. Most likely, the problem is a missing DOS 
driver that is required for your backup device, or incorrect command line parameters 
for the driver. Consult the documentation for your backup device for information on 
configuring it for use in DOS.
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▼ To test your Windows NT Disaster Recovery Set:

1. Insert the Windows NT Workstation Setup Boot Disk (diskette #1 of the DR Set) and 
restart your computer.

2. Follow the instructions on the screen until you receive a message indicating that the 
test is complete. 
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Disaster Recovery
The Disaster Recovery (DR) process enables you to recover from hard disk failure and 
should be used in emergency situations only. If you do not have a Disaster Recovery Set, 
see “Creating the Disaster Recovery Set” on page 58. If you created a DR Set, follow the 
steps below. 

Before using Disaster Recovery, decide if another recovery method can be implemented 
instead. For example, if the problem appears to be a Windows system problem, such as a 
corrupt registry, try to recover by following the steps outlined in your Microsoft Windows 
User's Manual before using Disaster Recovery.

If your hard drive failed completely and you have replaced it, Disaster Recovery may be 
the best method for recovery. However, you may also consider re-installing Windows, 
re-installing your backup software, then selectively restoring the rest of the files you need.

▼ To use Disaster Recovery for Windows 9x:

1. Replace any lost hard drives with comparable drives. 

Note In order to recover all of your information, Disaster Recovery must have at least as 
much hard disk space as existed before the drive failure.

2. Insert the Windows Startup Disk (diskette #1 of the DR Set) into your machine’s 3.5” 
boot floppy drive and restart your computer. 

A DOS screen appears.

3. If a Windows Startup Diskette #2 was created, (not all systems require the creation of a 
second diskette) insert that diskette into your machine’s 3.5” boot floppy drive, then 
press any key.

The Disaster Recovery screen appears.

4. If necessary, you can prepare your hard disk at this time using the following tools, by 
pressing Enter:

◆ DDIFF—Displays any differences between your current and original hard drive 
configurations

◆ *FDISK—Re-partitions your hard disk

◆ *FORMAT—Formats one or more partitioned drives

◆ *SYS—Installs the system boot files onto the hard disk

*For instructions on the use of these utilities, please refer to your operating system 
user manual or contact your operating system’s manufacturer.
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Note After using the FDISK utility, repeat steps 2-4 before continuing with the recovery.

When you are done preparing your hard disk, at the prompt, type (Your boot drive 
letter):\RECOVER, and press Enter.

5. To continue with Disaster Recovery, press F5.

6. Your system files will be copied from the diskette to your hard drive.

The following prompt should appear:

Please insert Disaster Recovery Media #1 into your (device 
name).

7. If it’s not already in your drive, insert media #1 of your DR Set into your device when 
prompted, then press Enter.

Note If your Disaster Recovery Set consists of more than one piece of media, you will be 
prompted to insert each media in the order it was created.

You will then be prompted to select a drive, or volume to recover. If you have only one 
drive, it will be automatically selected for recovery and this prompt will not appear.

8. Select the volume that you wish to recover by highlighting the volume using the Up 
and Down arrow keys, then pressing Enter.

You will then be asked to confirm your selections before recovering your information. 

9. Press Enter to confirm your selections. 

Note If media #1 of your DR Set is not in your drive, you will be prompted to insert it at 
this time.

Disaster Recovery will begin recovering the Windows File System.

10. Once the volume has been recovered, a summary of the process will be displayed. To 
exit this screen, press Enter. If there is more than one volume to be recovered, you may 
select it at this time.

After recovering the volume(s), you may wish to view the REPORT.TXT file which 
contains a text summary of the files that could not be recovered. If you wish to view this 
file, you must first exit the program by pressing the ESC key twice, then typing EDIT 
REPORT.TXT. After reading the text, press ALT+F, then press X to exit the editor. 

Your recovery is complete. Remove any media from your machine and restart your 
computer. 
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Note It may be necessary to restart your computer more than once if any hardware in 
your system has changed since your DR Set was created.

▼ To use Disaster Recovery for Windows NT:

A minimal install of the Windows NT Workstation will be performed from the Disaster 
Recovery Set.

Disaster Recovery screens will display messages instructing you when to insert each of 
the diskettes from your Disaster Recovery Set.

1. Insert the Windows NT Workstation Setup Boot Disk (diskette #1 of the DR Set) and 
restart your computer. You will be guided through a partial NT installation.

Only the boot drive and the NT installation drive need to be partitioned at this time. 
You will be able to partition and format other drives at a later time through the Disk 
Administrator in the Disaster Recovery process.

2. Restart your computer when prompted.

The Recovery Wizard should appear now and guide you through the steps necessary 
to recover your system.

Note If setup determines that your primary partition is not set up (i.e. if your C drive is 
not partitioned or formatted), then you will be prompted to do so.  You should 
attempt to partition any new drive(s) to the same settings as were set before the 
drive failure.

3. After you have restored all the files from your backup volumes, reboot the machine to 
complete your recovery.
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One-Button Restore
One-Button Restore launches a series of dialogs which help you perform a restore in just a 
few steps.

▼ To run One-Button Restore:

1. Click the Start menu, select Programs Backup Exec, and then click One-Button 
Restore. 

The One-Button Restore dialog box appears.

2. Select a device or File in the drop-down list box. 

3. Click Next to continue.

4. Check the drives, folders, and files you want to restore.

5. Click Start to begin restoring your files.
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Note If your backup job spanned more than one media, insert the first media of the 
backup set. Backup Exec will then prompt you to insert each additional piece of 
media.

Restore Default Settings

Your restore will run with the following default settings:

◆ What to Restore—Folder view. See “What to Restore” on page 75.

◆ Where to restore—Original Location. See “Where to Restore” on page 76.

◆ How to restore—Always replace. See “How to Restore” on page 77.
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Restoring All Your Files
This section explains how to quickly and easily restore all your files in the event of a hard 
disk failure. This procedure can also be used to transfer all your files to a new computer.

Before you can restore your files after a hard disk failure, you must first prepare your hard 
disk and reinstall Windows. Then follow these steps:

For Windows 9x

1. Install and configure Backup Exec. See “Installing Backup Exec” on page 8.

2. Collect the media containing your most recent All Selected Files and your New and 
Changed Files backups. Which backup sets you’ll need to restore depends on your 
backup strategy.

If you performed:

All Selected Files only—restore only your most recent backup set.

All Selected Files and Differential New and Changed Files—restore your All Selected 
Files backup first, then restore the most recent Differential backup set.

All Selected Files and Incremental New and Changed Files—restore your All Selected 
Files backup first, then restore each of the Incremental backups sets in order, starting 
with the oldest.

3. Restore the All Selected Files backup set. Make the following option selections on the 
Restore window:

What to Restore—Click Device view, then select each local drive.

Where to Restore—Choose Original Locations.

How to Restore—Choose Always replace.

4. Click Start.

5. If you used the Back up Windows Registry... option and backed up the registry, a 
prompt will appear asking if you would like to restore the Windows Registry. See 
“Advanced Tab” on page 50 for information on this option.

Caution Restoring the Registry may cause serious problems if your hardware 
configuration has changed since you last backed up the Registry.

If your system’s hardware configuration and system settings have not changed since 
the last backup of the registry, click Yes to restore the Windows Registry.

The entire registry will be restored along with all selected local drives.
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Or,

If your system’s hardware configuration has changed, (i.e. you’ve added a new drive 
or changed the IRQ settings on a card) click No when prompted to restore the 
hardware and system settings in the registry. Only those portions of the registry 
containing your software settings and configuration will be restored along with all 
selected local drives.

6. When the restore is complete, you are prompted to reboot your computer. Click Yes to 
reboot (recommended).

7. Restore any New and Changed Files backup sets using step 3 and 4.

For Windows NT

1. Install and configure Backup Exec. See “Installing Backup Exec” on page 8.

2. Collect the media containing your most recent All Selected Files and your New and 
Changed Files backups. Which backup sets you’ll need to restore depends on your 
backup strategy.

If you performed:

All Selected Files only—restore only your most recent backup set.

All Selected Files and Differential New and Changed Files—restore your All Selected 
Files backup first, then restore the most recent Differential backup set.

All Selected Files and Incremental New and Changed Files—restore your All Selected 
Files backup first, then restore each of the Incremental backups sets in order, starting 
with the oldest.

3. Restore the All Selected Files backup set. Make the following option selections on the 
Restore window:

What to Restore—Click Device view, then select each local drive.

Where to Restore—Choose Original Locations.

How to Restore—Choose Always replace.

Caution Restoring the Registry may cause serious problems if your hardware 
configuration has changed since you last backed up the Registry. 

If your system’s hardware configuration and system settings have not changed since 
the last backup of the registry, click Options in the Restore window and select Restore 
Windows Registry from the Advanced tab. For more information on the Advanced tab, 
see “Advanced Tab” on page 79.
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The entire registry will be restored along with all selected local drives.

Or,

If your system’s hardware configuration has changed, (i.e. you’ve added a new drive 
or changed the IRQ settings on a card) make sure the Restore Windows Registry 
checkbox is not selected. Only files selected from your local drives will be restored.

4. Click Start.

5. When the restore is complete, you are prompted to reboot your computer. Click Yes to 
reboot (recommended).

6. Restore any New and Changed Files backup sets using step 3 and 4.

Restoring Bindery Files

If you backed up files on your SYS volume or Novell Server and checked the Back up 
NetWare Bindery... option, you can restore your bindery files. See “Advanced Tab” on 
page 79 for more information on this option.

▼ To restore your bindery files:

1. Click the Restore tab.

The Restore window appears.

2. In the selection panes, select any file(s) on the SYS volume.

3. When prompted whether or not to restore the bindery, click Yes.
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Using the Restore Wizard
The Restore Wizard guides you through the steps required to run a restore, using a series 
of windows to let you choose the options used to create your restore job. After choosing 
an option, click Next to continue.

▼ To create your restore job using the Restore Wizard:

1. Click Restore Wizard in the Startup window and click OK, or click the Restore Wizard 
button on the toolbar, or select Restore Wizard from the Tools menu.

The Restore From window appears.

2. Choose the backup device, or File to restore from, then click Next.

The View files to restore window appears.

3. You may select your files from the catalog stored on your hard disk or from the media 
in your drive.

See “File Views” on page 75 for more information.

4. Click Next to continue.
70 Using Backup Exec



Using the Restore Wizard
The Restore selection pane window appears.

5. Click the check boxes next to the items you want to restore. For more information on 
file selection, see “Selection Panes” on page 19.

6. Click Next to continue.

The Where to Restore window appears.

7. Choose a destination for your restored files.

8. If you choose to restore to another location, type a path into the text box or click 
Browse. 

9. Files are restored in their original folder structure unless you check Restore all files to 
a single folder. See “Where to Restore” on page 76.

10. Click Next to continue.
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The How to Restore window appears.

11. Select an option. See “How to Restore” on page 77.

12. Click Start.

The Media Required box appears. Follow the instructions on the screen, then click OK.

The Restore Progress window appears.

See “Restore Progress Window” on page 82.

Note If your backup job spanned more than one media, insert the first media of the 
backup set. Backup Exec will then prompt you to insert each additional piece of 
media.
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The Restore Window
This section first describes the Restore window. For step-by-step instructions for restoring 
your files, see “Restoring Files with the Restore Window” on page 81.

The Restore window gives you quick access to all the restore options. The Restore window 
is composed of four sections.

◆ Restore from—Select the backup device to restore from, or select File if you backed up 
your files to a hard drive, network drive, a floppy drive, or removable media.

◆ File find—Locate the files you want to restore.

◆ What to restore—Select the files you want to restore.

◆ Where to restore —Select the location to restore your files to.

◆ How to restore—Select your overwrite option. 

Restore From

The Restore from box lists all available backup devices to restore from. To change the 
device you want to restore from, select another device in the drop-down list box. If you 
used the File selection and backed your files up to a hard drive, a network drive, a floppy 
diskette, or removable media, select File in the drop-down list box.
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Restore File

The File option enables you to restore your data that was backed up to a file in some 
custom location, such as a hard disk, a network drive, a floppy diskette, or removable 
media.

▼ To restore your data from a file:

1. Select File in the Restore from drop-down list box on the Restore window.

A text box and browse button appear below the drop-down list box. 

2. Type a folder and filename in the text box.

Or,

Click Browse, select a folder and a file within that folder, then click OK. The path 
appears in the text box.

File Find

The File Find option enables you to locate file(s) for restore. You can search by filename, 
location, and date modified. Backup Exec lists all the backed up files that match your 
criteria. 

You may terminate the File Find operation at any time by clicking the Close button.

▼ To search for files with the File Find option:

1. From the Restore tab, select the device that you used to back up your file(s).

2. Click the File Find button on the Toolbar, or select File Find from the Edit menu.

The File Find window appears. 

3. Enter a file name and path (if no path is entered, Backup Exec searches all paths). 

4. To search by date, click the Date Modified tab and enter a date or date range.

5. To start searching, click Find Now.

Backup Exec searches the catalog that corresponds to the selected device and displays 
a list of all files that match the search criteria. 
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6. When the search is completed, the file name and path will appear in the window. Set 
options, if necessary, by clicking the Options button and choosing from the Restore 
Options tabs. Set your options, then click Start.

7. The Media Required box appears. Follow the instructions on the screen, then click OK.

What to Restore

Select a file view and files to restore in the What to restore section. 

Catalog

Each time you make a backup, Backup Exec creates a backup catalog. This catalog 
contains information about the files and folders that were backed up and the Backup Job 
used. Backup Exec uses the information in the backup catalog to restore or compare 
backed-up files.

After viewing the backup catalog, you may find items you no longer need to restore or 
compare. To remove these items from the backup catalog, use the Catalog Clean Up tool 
located on the Tools menu. See “Catalog Clean Up” on page 94 for more information.

Note If you get a message indicating the catalog is empty, select Device view on the 
Restore window.

File Views

Backup Exec provides three different view options to help you select the files you need to 
restore.

◆ Folder view—displays the catalog on the hard disk using the traditional file tree 
system. Folder view displays cataloged files filtered by the selected backup device. 
Use this view when you want to see all the files currently on your hard drive.

◆ Media view—displays the catalog on the hard drive sorted by media. Media view 
displays cataloged files for all devices. Use this view when your backup spans more 
than one media, or if you have multiple backups (i.e. Incremental) and you wish to 
see the files for a particular backup job.
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◆ Device view—displays the contents of the media currently in the drive. Device view 
displays all logged files for the selected device. Use this view when you want to see 
the contents of a single piece of media.

Note If you wish to view a backup set during Device View that spans more than one 
media, you must insert all media in sequence.

Restore Selection Panes

Backup Exec uses the same drive and file selection methods as the Windows Explorer. 
Drives and folders are selected in the All Folders pane, and individual files and folders are 
selected in the Contents pane. Select drives and files to restore by clicking the check box 
next to the item. For more information, see “Selection Panes” on page 19.

Multiple File Versions

If you back up the same set of files more than once, you will be able to restore any version 
of the files you backed up. 

By default, Backup Exec restores the most recent file version. To restore an older version, 
choose Version from the Edit menu or toolbar and use the File Version dialog box, which 
lists each available version’s size and date/time modified.

You can also open the File Version dialog if you right-click a file in the Restore selection 
pane, and then click Version.

Where to Restore

You’ll usually want to restore files to the same place from which you backed them up. 
However, if you want to restore your files to a different location, use the Where to restore 
box. The following selections are available:

◆ Original Location—All files and folders are restored to the same path from which they 
were backed up. This is the default setting.
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◆ Alternate Location—All files and folders are restored using the original tree as backed 
up, but the root of the tree is set to the specified path.

◆ Single Directory—All files and folders are restored to a single folder, specified in the 
path text box.

▼ To restore your files to an alternate location:

1. Select Alternate Location from the Where to restore list.

2. Type a path into the text box.

Or,

Click Browse, select a folder in the list, then click OK. The folder appears in the text 
box.

▼ To restore your files to a single folder:

1. Select Single Directory from the Where to Restore drop-down list box.

2. Type a folder (directory) name into the text box.

Or,

Click Browse, select a folder from the list, then click OK. The folder appears in the text 
box.

How to Restore

Restore options lets you choose how to treat files in your backup set with the same name 
as those on your hard drive.

▼ To set your restore options:

1. Click Options in the Restore window.

The Restore Options dialog box appears:

2. Choose a Restore option.
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General Tab

◆ Do not replace—Never replace the files on the hard disk, even if the backed-up file is 
a more recent version than the file on the hard disk.

◆ Replace older files—Replace only older files with the most recent file versions.

◆ Always replace—Always replaces the files on the disk. 

Caution Always Replace will always overwrite the files on your hard disk with the 
backed up files. 

Report Tab

Use the Report tab to specify the items you want to include in your restore report and to 
set your unattended restore option.

◆ List all files that were restored—Includes a list of the files that were selected and 
successfully restored.
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◆ List files that were not restored—Includes a list of the files that were selected, but not 
successfully restored.

◆ List errors reported while restoring files—Includes a list of any errors encountered 
while restoring files.

◆ List warnings reported while restoring files—Includes a list of any warnings 
encountered while restoring files.

◆ List unattended messages and prompts—Includes a list of any messages and prompts 
encountered while performing an unattended restore.

◆ Show report summary—Includes a report summary of the results of the restore.

Unattended restore

Check Unattended restore to run unattended restore jobs. This option enables the 
program to bypass most prompts during a restore operation. Unattended restore is the 
default setting.

Advanced Tab

Use the Advanced tab to specify the following options:

◆ Restore Windows Registry—Restores the Windows Registry.

◆ Restore Netware Bindery...—Restores the Netware Bindery when a Netware system 
volume is selected for restore. Backup Exec will restore NetWare 3.11-3.12 server 
bindery, and NetWare file and directory attributes from NetWare server volumes, 
including trustee information. 

◆ Restore NTFS File Permissions—Restores user ’s permissions to files and directories.

Note If you are running under Windows 9x, the Restore NTFS File Permissions option will 
not be available.
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▼ To set the Advanced Options:

1. Click the Advanced tab in the Restore Options dialog box.

The Advanced tab appears.

2. Check the option you want.

3. Click OK.
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Restoring Files with the Restore Window

▼ To restore files using the Restore window: 

1. Click Blank Restore Job in the Startup window, or click the Restore tab from the Main 
or Program window.

The Restore window appears.

2. Select the backup device containing the files you wish to restore. 

Note If you backed your files up to a hard disk, network drive, a floppy diskette, or 
removable media, select File. See “Restore File” on page 74.

3. To choose your files from your backup device instead of from the catalog on your hard 
disk, select Device view. See “File Views” on page 75.

4. Place a checkmark in the box next to the drive and files you want to restore.

5. To change your restore location, select another location in the Where to restore box. See 
“Where to Restore” on page 76.

6. To change your restore options, click Options. Change the settings for the restore job 
under the options tabs, click Apply, then click OK. See “How to Restore” on page 77.

7. On the Restore window, click Start.

8. The Media Required box appears, follow the instructions on your screen, then click OK.
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Restore Progress Window

The Restore Progress window appears when you click OK, and provides information 
about your restore job. It is divided into three sections.

The top section lists the selected backup device and the name of your media. It also 
displays the current status of your restore job.

The center section displays a progress bar and the time elapsed since the start of restore.

The bottom section lists the name of the file currently being restored, and the estimated 
number and size of the files restored.

You can cancel the restore job at any time by clicking the Cancel button or pressing Esc.

When the restore job is complete, the Cancel button changes to OK and a Report button is 
displayed below it. Click Report for a summary of your restore or click OK to continue.
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 4

This chapter explains how to use the Compare window to read data from the backup set 
and compare it to the data on the hard disk. You can compare one file, selected files, or all 
files in the backup set.

Compare is a separate function designed to provide maximum data security. After you 
have created a backup set, you can go to the Compare window and verify that the 
information contained on the backup media is identical to the data on the hard disk and 
that it can be restored. 

It is strongly recommended that you perform compares after your first few backups and 
after changing your system’s configuration. This will confirm Backup Exec is running 
properly on your computer.

Performing a compare at any time in the future lets you see how the files in the backup set 
differ from the files currently on the hard disk.

Where to Look—Compare

▼ For more help on compare topics, see:

◆ “The Compare Window” on page 84

◆ “Comparing Files with the Compare Window” on page 87

◆ “Compare Progress Window” on page 88
83



The Compare Window
The Compare Window
The Compare window gives you quick access to all the compare options. It consists of 
three main sections:

◆ Compare from—Select the backup device to compare from.

◆ What to compare—Select the files you want to compare.

◆ Where to compare—Select the location to compare your files to.

Compare From

The Compare from drop-down list box lists all available backup devices to compare from. 
To change the drive you want to compare from, select another drive in the drop-down 
list box. If you used the File selection and backed your files up to a hard drive, a network 
drive, a floppy diskette, or removable media, select File in the drop-down list box.

Compare File

◆ The File option enables you to compare your data that was backed up to a file in some 
custom location, such as a hard disk, a network drive, a floppy diskette, or removable 
media.
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▼ To compare your data from a file:

1. Select File in the Compare from drop-down list box on the Compare window.

A text box and browse button appear next to the drop-down list box. 

2. Type a folder and filename in the text box.

Or,

Click Browse, select a folder and a file within that folder, then click OK. The path 
appears in the text box.

What to Compare

Select the files to compare in the What to compare section.

File Views

Backup Exec provides three different view options to help you select the files you want to 
compare.

◆ Folder view—displays the catalog on the hard disk using the traditional file tree 
system. Folder view displays cataloged files filtered by the selected device.

◆ Media view—displays the catalog on the hard drive sorted by media. Media view 
displays cataloged files for all devices.

◆ Device view—displays the contents of the media currently in the drive. Device view 
displays all logged files for the selected device.

Compare Selection Panes

Backup Exec uses the same drive and file selection methods as the Windows Explorer. 
Drives and folders are selected in the All Folders pane, and individual files and folders are 
selected in the Contents pane. Select drives and files to compare by clicking the check box 
next to the item. For more information, see “Selection Panes” on page 19.
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Where to Compare

You’ll usually want to compare files to the same drive and directory as the one from which 
they were backed up. If their location has changed, however, the Where to compare box lets 
you specify where the original files are now located.

▼ To compare your options to an alternate location:

1. Select Alternate Location from the Where to compare drop-down list box.

2. Type a path in the text box.

Or,

Click Browse, select a folder in the list, then click OK. The folder appears in the text 
box.

▼ To start comparing your files:

❖ Click Start. 
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Comparing Files with the Compare Window

▼ To compare your files:

1. Click the Compare tab in the Main Application window.

The Compare window appears.

2. Select the backup device containing the backup set you wish to compare in the 
Compare from drop-down list box.

3. Select the files you wish to compare. See “Selection Panes” on page 19 for more 
information.

4. Select a location in the Where to Compare drop-down list box.

5. Click Start. 

6. The Media Required box appears. Follow the instructions on your screen, then click 
OK.

The Compare Progress window appears.
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Compare Progress Window

The Compare Progress window appears when you click OK, and provides information 
about your compare. It is divided into three sections. 

The top section lists the selected backup device and the name of your media. It also 
displays the current status of your compare job.

The center section displays a progress bar and the time elapsed.

The bottom section lists the name of the file currently being compared, and the estimated 
number and size of the files compared.

You can cancel the compare at any time by clicking the Cancel button.

When the compare is complete, the OK and Report button replace the Cancel button. Click 
Report for a summary of your compare or click OK to continue.
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 5

Backup Exec offers several tools to help you handle your media, catalog, and reports. This 
chapter describes how to use Media Tools, Report Tools, Catalog Tools, and Preferences. 

Where to Look—Tools

▼ For more help about tools topics, see:

◆ “Media Tools” on page 89

◆ “Report Tools” on page 93

◆ “Import Catalog” on page 93

◆ “Catalog Clean Up” on page 94

◆ “Preferences” on page 94

Media Tools 
The following Media Tools commands are located on the Tools menu. 

Note If you have more than one backup device configured, each device will be listed and 
will have its own set of tools. Different drive types use different tool sets.

Identify 

This command displays the media name and contents. 

▼ To identify a media:

1. Select Media from the Tools menu, then select Identify.

The Identify window appears. The device name and media name are displayed.
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2. To view the backup sets on the media, click Device View in the Identify Progress 
window.

3. Select OK to close the Identify window.

Initialize

This command erases the header portion of the media, making all the data on the media 
inaccessible. Using this command is substantially faster than the Erase command, but 
somewhat less secure, since some data will remain on the media after initializing. 

▼ To initialize a media:

Caution Initializing a piece of media destroys all data on the media.

1. Select Media from the Tools menu, then select Initialize.

If the media contains data, you are prompted to confirm the initialize.

2. Click Yes to confirm the operation or No to cancel.

If you are using SCSI media, you may enter a new media name.

3. Click OK.

The Initialize Progress window appears.

Erase

This command erases all files on the media, and positions the media to start writing or 
recording. The Erase command takes more time to complete, but is more secure than the 
Initialize command, since it erases all data on the media. Use this command if you are 
concerned about the security of the data on your media. Since the Erase command is not 
supported by all devices, you may need to use the Initialize command to prepare your 
media for use.

▼ To erase a piece of media:

Caution Erasing destroys all data on the media.

1. Select Media from the Tools menu, then select Erase.

If the media contains data, a message box appears asking you to confirm the erase.

2. Click Yes to confirm the operation or No to cancel.
90 Using Backup Exec



Media Tools
The Erase Progress window appears.

Retension

This command winds and rewinds a tape to remove any slack and evenly tension the tape 
by performing a fast forward and rewind. It is not applicable to other media, such as 
writable optical devices.

▼ To retension a tape:

❖ Select Media from the Tools menu, then select Retension.

The Retension Progress window appears.

Or,

To have Backup Exec automatically retension your tape before each backup, select 
Preferences from the Tools menu, and place a check mark next to the Retension the 
tape before each backup option.

Rename

Note This section applies to Windows 9x only

Use this command to rename your QIC medium.

If you rename your medium, be aware that backup sets with the old medium name will be 
removed from the catalog. If you want to restore or compare files that you backed up 
before you renamed your medium, you need to perform a Device View. Any backup sets 
that you create after you rename your medium will appear in the catalog.

▼ To rename a QIC medium:

1. Select Media from the Tools menu, then select Rename.

A dialog appears displaying the name for the inserted QIC medium.

2. If you wish to rename your QIC medium, type a name in the text box, then click OK.

Security Erase

This command erases the cartridge and overwrites the data with zeros, so that it cannot be 
read. Security Erase can take several hours to complete, depending on the media type.
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▼ To security erase a tape:

1. Select Media from the Tools menu, then select Security Erase.

Your tape will spin for several seconds. If your tape contains one or more backup sets, 
a warning is displayed before the security erase begins.

2. Click OK to erase or Cancel to cancel the security erase operation.

Format 

Note This section applies to Windows 9x only

This command formats media. When media is formatted, all data on the media is lost. 
Formatting can take several hours to complete, depending on the media type.

Note SCSI devices use the Initialize media tool instead of the Format media tool.

▼ To format QIC media:

Caution Formatting destroys all data on the media.

1. Select Media from the Tools menu, then select Format.

If the media contains data, a message box appears asking you to confirm the 
operation.

2. Click Yes to confirm the operation or No to cancel.

3. Enter a new media name, then click OK.

If the drive supports multiple capacities, you are prompted to select either a high or 
low capacity format.
92 Using Backup Exec



TapeAlert
TapeAlert
The TapeAlert feature detects errors on TapeAlert-supported drives by constantly 
checking the drive for potential failures, and reporting these problems to you before they 
occur. When an error is detected, a dialog is displayed explaining the error, and offering 
instructions on how the problem can be resolved. 

Report Tools
Report tools give you access to the backup log or report, which provides backup 
information and error messages. The following commands are available under the Report 
sub-menu.

◆ View—Launches Notepad with the log file loaded and displays the last five reports.

◆ Print—Launches Notepad, prints the log file, and exits Notepad.

Tip Click Report on the Progress window to view the report for the current backup, 
compare, or restore operation.

Import Catalog
To add backup sets to your catalog, use the Import Catalog command from the Tools 
menu. This allows you to recatalog backup sets or media that have been deleted or to add 
files from media that have been backed up on a different system.

▼ To import items into your backup catalog:

1. On the Restore or Compare window, select Import Catalog from the Tools menu. 
Device View is selected.

2. Select the backup set you wish to add to your catalog in the Select Backup Sets dialog 
box.

3. Click OK. The items in the backup set are added to your catalog.

Note The media is searched and catalog information is added to your catalog. If the 
backup set is very large, this operation can take several minutes.
Chapter 5, Tools 93



Catalog Clean Up
Catalog Clean Up
The Catalog Clean Up tool helps you manage your catalog. Use this tool to delete backup 
sets or media from the backup catalog. This command displays the Catalog Clean Up 
dialog box. See “Catalog” on page 75 for more information.

Note If you remove backup sets or media from the catalog, you must perform a Device 
View to restore or compare them.

▼ To delete items from the backup catalog:

1. On the Restore or Compare window, select Catalog Clean Up from the Tools menu.

The Catalog Clean Up dialog box appears.

2. Select media or a backup set in the Remove from catalog list box.

3. Click Remove.

4. Click Yes to confirm this operation or No to cancel.

Tip If you want to compact the catalog so that it occupies less space, click Compact on 
the Catalog Clean Up dialog box.

Preferences
The Preferences dialog box lets you set the following options:

General

◆ Show startup dialog when Backup Exec is started.—The startup screen is displayed 
each time the program starts.
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◆ Show the number and size of files before backing up, restoring and comparing 
data.—The estimated number and size of files selected are displayed. This option also 
enables Backup Exec to display time estimates and file counts in the Progress 
windows.

◆ Retension the tape before each backup.—This command automatically winds and 
rewinds a tape to remove any slack and evenly tension the tape before each backup.
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Troubleshooting Tips
 6

This chapter provides troubleshooting tips to solve the most common configuration, 
compatibility, and other issues.

Where to Look—Troubleshooting

▼ For more help on troubleshooting topics, see:

◆ “Backup Device Configuration” on page 97

◆ “System and Software Lockups” on page 102

◆ “Common Error Messages” on page 104

Backup Device Configuration
This section is designed to help you configure your system. You will find useful 
troubleshooting tips that can help you solve most of the problems you may encounter. 

*Backup Exec supports plug and play operation. However, if for some reason your backup 
device is not automatically detected, this section provides instructions on manually 
configuring your drive or controller. Chances are you won’t need to manually configure 
either of them. See your device type below for specific steps.

*For Windows 9x only

Conflicts With Drivers from Other Backup Programs

Some driver files from other backup programs and Windows 3.1 applications may conflict 
with your backup software. “Driver File Lines and Associate Applications” on page 98 
lists the driver files, with their associated applications, that may be causing a conflict. 

As a troubleshooting step, disable any drivers on your system that might cause conflict. 
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Caution If you are running the applications associated with these driver files, do not 
remove them permanently.

▼ To disable drivers that may be creating conflicts:

1. Make a copy of your SYSTEM.INI file (found in your Windows folder) and name the 
copy SYSTEMBKUP.INI. This provides an unmodified copy of your original file.

2. Click Run on the Start menu.

3. Type system.ini and click OK. The SYSTEM.INI file opens in Notepad.

4. In the [386Enh] section of your SYSTEM.INI file, type a semi-colon (;) at the 
beginning of the driver file lines listed below. The semi-colon disables the driver that 
may be causing a conflict.

5. Save the modified SYSTEM.INI file and restart your computer.

If you find that any of the programs listed below with a dagger (†) are causing the conflict, 
you should obtain the Windows version of the software to eliminate the problem.

Table 2. Driver File Lines and Associate Applications

Driver File Line Application

device=cmswtape.386 Colorado Backup for Windows

device=cmsdtape.386 Colorado Backup for DOS

device=vfintd.386 Backup Exec, Conner Backup,

Iomega Backup, Norton Backup

device=cpbvxd.386 Central Point Backup

†device=symevnt.386 Symantec Norton Utilities

†device=adw30.386 After Dark Screen Savers

†device=awdos.386 PCanywhere for DOS

†device=vpcaw.386 PCanywhere for Windows

device=fastback.386 Fastback Backup

device=irw286.drv Irwin Eztape Backup

device=novabkp.386 Novastor Backup

device=virwt.386 Irwin EZtape Backup
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Conflicts With Other Programs

▼ If the problem persists:

1. Make a copy of your WIN.INI file (found in your Windows folder) and name the copy 
WINBKUP.INI. This provides an unmodified copy of your original file.

2. Click Run on the Start menu.

3. Type win.ini and click OK. The WIN.INI file opens in Notepad.

4. Type a semi-colon (;) at the beginning of the load= and run= lines, then save the file.

5. Restart your computer and run Backup Exec.

Conflicts With Other Device Drivers

Note This section applies to Windows 9x only.

If the problem continues, try changing the file extension of any Backup Exec drivers that 
are not in use to .old.

▼ To change the file extension of Backup Exec drivers that are not in use:

1. Open the Explorer, double-click Windows, double-click System, then double-click 
Iosubsys.

The contents of the Iosubsys folder appear in the right pane.

2. Search for the files listed in Table 2, and change their file extensions to .old. For 
example, rename drvwppqt.vxd to drvwppqt.old

3. Restart your computer and run Backup Exec.

Table 3. Drivers Not In Use

If you are using this device: Change these files:

SCSI backup device drvwppqt.vxd

drvwq117.vxd
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SCSI Backup Devices

If your system cannot locate your SCSI backup device, disable any real-mode drivers 
loading in your CONFIG.SYS file. Follow the steps below:

1. Click Run on the Start menu.

2. Type sysedit.exe and click OK.

3. Click on the CONFIG.SYS window.

4. Type rem at the beginning of each line that contains a real-mode driver. For example, 
rem device=C:\aspi\aspi4dos.sys

5. Save the CONFIG.SYS file.

6. Restart your computer and run Backup Exec.

Parallel Port Backup Device

If your system cannot locate your Parallel Port device, you may have an IRQ conflict.

▼ To check for IRQ conflicts:

1. Right-click the My Computer icon and select Properties.

2. Click the Device Manager tab in the System Properties window.

3. Computer is highlighted and appears at the top of the list. Click Properties.

4. Make sure your printer port drive is the only device with an IRQ setting of 07. If 
another device has the same IRQ setting, change that device’s IRQ setting to avoid 
conflicts.

Note Your printer port may not appear in this list. If it does not appear, change your 
printer port IRQ setting using the steps in the next section.

5. Restart your computer and rerun Backup Exec.

▼ To change your printer port IRQ setting to 07:

1. Right-click the My Computer icon and select Properties.

2. Click the Device Manager tab in the System Properties window.
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3. Double-click Ports in the list box, select Printer Port (LPT1), then click Properties.

4. Click the Resources tab, then write down your current Input/Output Range settings.

5. Uncheck Automatic Settings and select Basic Configuration 1 in the Setting based on 
drop-down list box.

Interrupt Request appears in the list box.

6. Highlight Interrupt Request and click Change Setting.

7. Select 07 for the new interrupt.

8. Click OK and verify that the Input/Output Range is at the setting you wrote down.

9. Click OK, then restart your computer.

▼ If the problem persists:

◆ Remove any conflicting drivers or programs. See “Conflicts With Drivers from Other 
Backup Programs” on page 97.

◆ Some drives may be incompatible with enhanced parallel ports (ECP/EPP). Check 
with your computer hardware vendor to confirm the kind of parallel port you have 
and to learn how to change the setting from ECP or EPP to a compatible setting, such 
as bi-directional.
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System and Software Lockups
If your system or software stops responding, there is often a conflict with outdated 
software drivers or with other software. This section will help you eliminate those and 
other conflicts.

Backup Exec Locks Up During Installation

If you are using DriveSpace or Stacker, install Backup Exec on a non-compressed volume. 

▼ To determine which volume is non-compressed:

1. Click the Start button on the taskbar.

2. Click Programs, Accessories, System Tools, DriveSpace 3.

3. You should now see a list of the compressed volumes as well as the Host drive (the 
host drive is non-compressed). If you double-click on the host volume it will indicate 
how much space is available.

4. Ensure that you have at least 10 MB available on the host drive.

5. Ensure that the host drive is not hidden. To unhide the host drive, click on the host 
drive and click the Properties button. Uncheck the Hide this host drive option.

6. Install Backup Exec to the host drive.

If Backup Exec still locks up after installation, boot Windows in Safe Mode by holding 
down F8 during boot-up. Install Backup Exec while in Safe Mode. When the installation is 
complete, reboot the system in normal mode and then run Backup Exec. If this procedure 
does not resolve the problem, contact VERITAS Software Technical Support (See 
“Technical Support” on page 107) and request replacement installation diskettes.

System Locks Immediately After Installation

If your system is locking up immediately after Backup Exec is installed, there may be 
conflicts between Backup Exec and other applications.

▼ To disable other applications: 

1. Press the CTRL, ALT and DELETE key at the same time to display the Close Program 
dialog box. 

The only application that can be running is the Explorer. 
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2. Close other applications by highlighting the desired application and clicking the End 
Task button.

If all applications have been disabled and Backup Exec is still not responding, rename 
(using an .OLD extension) the Backup Exec drivers not being used. 

Backup Exec Locks Up While Displaying Selection 
Information Before a Backup

Files in your Recycle Bin may be conflicting with other files on your hard drive. Delete the 
files in your Recycle Bin before using Backup Exec.

▼ To empty the Recycle Bin:

❖ Click the right mouse button on the Recycle Bin located on the Desktop, then select 
Empty Recycle Bin.

▼ To delete any protected files in the Norton Recycle Bin:

❖ Right click on the Norton Protected Recycle bin located on the desktop. Select Empty 
Norton Protected Files.

If the problem continues, files in TEMP and cache folders may be causing the backup 
software to appear locked up. Delete any on-line service TEMP folder files or Cache folder 
files. Most on-line and web browsers allow you to purge their disk cache (for example, 
Netscape, Microsoft Internet Browser, or AOLnet). 

▼ To delete these temp files:

1. In NetScape Navigator, click Options, Network Preferences, Clear Disk Cache Now.

Or,

In Microsoft Internet Explorer, click View, Options, then Advanced tab. In the cache 
box, click Empty.

2. Launch Backup Exec and start the backup again.
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Common Error Messages
This section lists some common backup device errors. The most commonly received error 
messages

ASPI Manager Not Found or ASPI Manager Not Responding 

1. Lower the rate at which data is transferred to the backup device from the SCSI BIOS to 
5MB/sec. Refer to your hardware manual for complete instructions.

2. Ensure the SCSI backup device has a low SCSI ID (for example, a lower ID than a 
CD-ROM installed on the system).

3. Contact your hardware vendor for the latest BIOS or Firmware for your SCSI adapter 
card and/or backup device and get the latest Windows miniport driver for your SCSI 
controller.

4. First see “Conflicts With Drivers from Other Backup Programs” on page 97 for 
troubleshooting tips.

Device Driver Error 

Device driver errors will contain the following number format in the error dialog: 
XX-XX-XX-XX-XXXX

▼ To solve device driver errors:

1. Close any open applications.

2. Disable advanced power management or screen savers.

3. Update drive firmware.

4. Update controller driver (SCSI).

5. Replace media.

6. Check physical hardware configuration.

DMA Conflict During Backup or Compare

If the problem continues, follow the steps below.
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1. Go to Device Manager and double-click the backup device item. 

2. Select the backup device and click Properties. 

3. Select the Settings tab and disable high speed burst mode, concurrent video update, 
and concurrent hard disk access.

4. Reduce the transfer rate to its lowest setting.

If you still have a DMA conflict problem, use the lowest resolution setting available on 
your video card. If this fixes the problem, contact your video card or computer 
manufacturer for available driver updates for Windows.

Media Not Formatted or Unreadable

If you are receiving a “media not formatted or unreadable by drive” error and are using 
an internal backup device, try these steps:

1. Right-click the My Computer icon and select Properties.

2. Click the Device Manager tab in the System Properties window.

3. Click the plus sign next to your backup device type to expand the tree, then 
double-click your backup device.

4. Click the Settings tab in the Properties window.

5. Uncheck the High speed burst transfers option and click OK.

6. Restart your computer.

Media Formatter Error

Media formatter errors will contain the following number format in the error dialog: 
XXXX-XXXX

▼ To solve media formatter errors:

1. Clean the drive (for information on cleaning the drive, see the hardware 
documentation). 

2. Try another piece of media.

3. Try restoring your data to another machine, or drive.
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4. Follow steps 1-6 in the section “Device Driver Error” on page 104.
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 7

Many problems can be solved with the on-line help system or User's Guide. You can 
always press F1 to get help for the active window or dialog box. If you have a problem 
that cannot be solved using the on-line help or this User's Guide, collect the information 
describedin “Preparing for Technical Support,” then contact technical support.

Preparing for Technical Support
Write down your exact problem. Include the following information:

◆ Name and version number of your program copy.

◆ The wording of any error messages from your backup software, DOS, Windows, or 
any other application involved in the problem.

◆ Your computer name and model.

◆ Names and models of any additional hardware (expanded memory boards, special 
video cards, tape drive controllers, etc.).

◆ Operating system and version number (including Windows).

◆ Can you consistently reproduce the problem you are having?

◆ Has this problem occurred previously? If it is new, did you change your system 
configuration recently?

▼ When calling, follow these guidelines:

◆ Call from a phone next to your computer.

◆ Please have your notes ready with the information described above, then contact 
technical support.
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